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Sobre el Plugin RightFax  
El Plug-in de Reform Rightfax permitirá Reform 12 interactuar con un servidor de 
RightFax para distribuir automáticamente los documentos en el sistema de fax. 
 

Requisitos del Sistema 
• Reform 12 Enterprise o Reform 12 PDC 
• Plugin RightFax 
• Para evaluación y demostración: Windows XP, Windows 2003 Server, Windows 

Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de 64 
bits) 

• Para los sistemas de producción: Windows Server 2003 o Windows Server 2008 
(sistemas operativos de 64 bits son compatibles) 

• Aplicación FaxUtil de RightFax instalación en el Servidor de Reform (para 
cliente) 
 
Todas las descargas de Software Reform pueden ser encontradas en www.fabsoft.com 
>> Sección de Descargas. 

Requisitos de Hardware 
• Recomendación de sistema de producción (estas sugerencias son sólo 

estimaciones. Entornos de alta carga pueden requerir varios servidores o hardware 
adicional.) 

1. Procesador Pentium 4 
2. 4 GB RAM 
3. HDD Space 100 GB (Redundancia recomendada) 
4. Respaldo de Batería (UPS) 
5. Servidor dedicado, no hay otros productos de software excepto 

para los programas de antivirus y seguridad. 
• Requisitos mínimos del sistema sólo con fines de demostración 

1. Procesador Pentium 4 
2. 2 GB RAM 
3. Espacio HDD 30 GB 

 
Especificaciones de hardware dependen enormemente de la carga de trabajo y el 
rendimiento que se requiere.  Procesadores de gama superiores y una mayor cantidad 
de memoria aumentará la cantidad de información y datos que Reform puede 
procesar, mejorando el rendimiento general del sistema.  Para equilibrio de carga y 
failover, también pueden utilizar varios servidores. (Nota: se requiere para cada 
servidor que ejecuta el software de una licencia para Reform y cada complemento.) 
Antes de obtener el servidor que desea utilizar para Reform, compruebe los manuales 
de usuario de los plug-ins para requisitos del sistema, así como pueden requerir 
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hardware adicional. Para sistemas de producción, se recomiendan también discos 
duros redundantes utilizando las características de espejo de RAID (Redundant Array of 
Independent Disks) para minimizar la pérdida de datos y acelerar la recuperación del 
sistema en caso de una falla de hardware. También se sugieren respaldos de batería 
para mantener la disponibilidad del sistema y fiabilidad en caso de fallo de 
electricidad.     
 

Instalación 
Para instalar el Plug-in Reform Rightfax a su instalación existente de Reform 12, 
descargar y ejecutar el ejecutable de instalación Reform Rightfax. 
 

 
 

Pasar a través de los mensajes, y comenzará la instalación. Permita que la instalación se 
complete y después continúe a la siguiente sección para aprender como implementar 
Reform Rightfax a sus formularios. 
 
El directorio de instalación predeterminado para Reform 12 y sus plug-ins es C:\Program 
Files\Reform. Si ha cambiado la ruta durante la rutina de instalación Reform, o si utiliza 
un sistema operativo de 64 bits, consulte la ruta adecuada en lugar de la 
predeterminada uno al que hace referencia a lo largo de esta documentación.  

Plugin de Registro y Licencias 
Al evaluar Reform 12, los plugins también estarán en un modo de evaluación para ese 
período de tiempo. Una vez que Reform ha sido comprado y con licencia, se debe poner 
licencia a los plugins usados para continuar funcionando correctamente.    
 
Consulte la sección "Reforma 12 licencias y registro" del Manual de Usuario Reform para 
más información acerca de cómo dar licencias a los Plug-ins de Reform 12.  Despues de 
introducir la licencia, el Reform Spooler se tendrá que reiniciar para actualizar las 
licencias. Puede encontrar más información sobre el servicio Reform Spooler en el 
Manual de usuario de Reform 12. 

Configuración del primer formulario Habilitado RightFax  
En este tutorial, vamos a crear un nuevo formulario de una plantilla existente y, a 
continuación, se configura usando el  Workflow Designer para enviar documentos a un 
servidor de RightFax. El plug-in de RightFax puede configurarse fácilmente usando el  
Workflow Designer. 
 
Primero, el Reform Designer debe iniciarse. Para abrirlo, ir a:  
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 Start>Programs>Reform…>Designer. 
 
1. Por ejemplo, crearemos un nuevo formulario con una plantilla existente. Ir a 

File>New>New. Seleccione la plantilla Fax y haga click en OK. 
 

 
 

2. Cuando le pregunta si desea abrir un archivo de texto para el diseño, seleccione No. 
3. A continuación, vaya a File>Save para guardar el formulario. Llámelo Fax.fom. 
4. Usted ahora puede cerrar el Reform Designer ya que tenemos nuestro formulario 

que va a utilizar junto con el Workflow Designer para distribuir el documento. 
 

* Ahora que tenemos nuestro formulario, podemos empezar a cumplir con el flujo de 
trabajo de RightFax deseado usando el Workflow Designer.  En primer lugar, se debe 
iniciar el Workflow Designer.   

5. Para abrirlo, ir a Start>Programs>Reform…>Workflow Designer. 
6. Una vez abierto, debemos ir a File > New… 

 

 

7. Seleccionar “Document Automation” y haga click en Ok. 
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8. Ahora verá que sus entradas, procesos y salidas han sido pobladas por los diversos 

plug-ins que han instalado (RightFax siendo una de las salidas) 

 

9. Podremos empezar a agregar los componentes necesarios para el flujo de trabajo. 
En primer lugar, arrastrar y soltar un objeto Form and File en el flujo de trabajo 
haciendo click con el mouse en Form and File y, a continuación, mover el mouse 
sobre el flujo de trabajo y soltar el botón del mouse.  
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* Se le presentará el siguiente cuadro de diálogo: 
 

 
 

10. Escriba una descripción para el objeto que acaba de agregar. Para ello, escriba en el 
cuadro proporcionado. Escriba “RightFax Demo” y haga click en Finish. Esto le 
llevará de regreso a su flujo de trabajo. 

11. Ahora estamos listos para configurar el formulario “RightFax Demo” y el archivo de 
entrada.  Para ello, haga click derecho en el objeto recién agregado y seleccione 
“Configuration…” o  simplemente haga doble click en el. 

 
 

12. Ahora aparecerá la ventana Configuración de entrada. En primer lugar, queremos 
que seleccione la secuencia de datos o archivo de texto que va a utilizar nuestro 
formulario.  Para ello, simplemente puede empezar a escribir en el cuadro o puede 
navegar hasta encontrarlo.  Queremos que seleccione el archivo Fax.out.  Haga 
click en el icono de carpeta pequeña para abrir una ventana que escoge ese 
archivo.  Seleccione el archivo y haga click en Open.   
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13. Después de seleccionar el archivo de texto, volverá a la página de configuración de 
entrada para que ahora puede seleccionar un formulario.  Haga click en el icono de 
carpeta pequeña para abrir una ventana que nos escoge el archivo deseado de 
formulario Fax.FOM.  Seleccione el archivo FOM y haga click en Open.  
 

 
 

14. Ahora que tiene el archivo de texto de entrada y el Formulario Reform 
seleccionado, la configuración del formulario y el archivo esta completo. Puede 
comprobar rápidamente que los archivos correctos son seleccionados y, a 
continuación, haga click en Finish.  
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15. También deberá agregar un campo de salto de página a los formularios.  En este 
punto, queremos seleccionar No. 
 

16. Para terminar el flujo de trabajo de Fax, queremos añadir una salida RightFax.  
Usamos el mismo procedimiento de arrastrar y colocar, como con Form and File 
(consulte el paso 9).  Tomar el mouse y arrastre el objeto  “RightFax” debajo de 
salida hasta el flujo de trabajo en algún lugar debajo de la entrada. Una vez que 
suelte el mouse, se le pedirá describir  RightFax.  Escriba “RightFax” en el cuadro y, 
a continuación, haga click en Finish. 

 

 
17. Una vez que haga click en finalizar, volverá a su flujo de trabajo. Su RightFax tendrá 

un título Rojo porque no se ha configurado aun. Para configurar RightFax, primero 
debe conectar el objeto Form and File llamado “RightFax Demo”.  Para ello, 
seleccione primero el botón “Add Connector” de la barra de menús. A 
continuación, arrastre el mouse de la pequeña “x” debajo de “RightFax Demo” 
hacia la pequeña “x” encima de “RightFax” como muestra la imagen a 
continuación. Cuando se completa la conexión, el conector se volverá negro (si es 
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roja, la conexión no se ha realizado correctamente, inténtelo de nuevo) y el título 
de “RightFax Demo” cambiará a verde. 

 
18. Deberá configurar RightFax al finalizar la conexión.  Haga click en Yes.   I Si hace click 

en No, también puede hacer doble click en el objeto RightFax o click derecho y 
seleccionar “Configuration…”.  Esta configuración le guiará a través de toda la 
configuración necesaria para que RightFax se conecte satisfactoriamente al Servidor 
RightFax y mande faxes. La primera página solicitará el nombre del servidor y el 
nombre de usuario que se utilizará para conectarse al servidor de RightFax. 
Introduzca el nombre del servidor y el tipo de cuenta y, a continuación, haga click en 
el botón Next.  
 

 
 

19. La siguiente pieza de información, que la configuración requiere, es el FaxNumber al 
cual mandar el fax.  Introduzca un número de fax válido, escriba en el cuadro 
proporcionado y, a continuación, haga click en Next. 
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20. A continuación es el “Recipient’s Name”.  Aquí, nos gustaría utilizar datos 
disponibles en la secuencia de datos en lugar de un valor estático. Para ello, 
primero debemos pulsar el botón “Click here to select variable information”.  
 

 
*Nota- Después de hacerlo, vemos que aparece una lista con los diferentes campos 
que puede elegir para los datos variables. Si desea volver a modo de entrada 
estático, puede hacerlo haciendo click en el botón correspondiente para obtener 
información estática y, a continuación, podrá escribir información estática. 
 

    RightFAX 



Reform To Open Text RightFax  12 
 

 

21. Queremos utilizar el campo dinámico ClientName como el “Recipient Name”.  
Seleccione ClientName de la lista y haga click en Next. 
 

 
 
22. Para “Recipient’s Company Name”, nos gustaría volver a utilizar datos variables de 

la secuencia de impresión. Para ello, primero haga click en el botón “Click here to 
select variable data”.  De la lista que aparece, seleccione ShipToName (desplazarse 
hacia abajo) y haga click en Next. 
 

 
 

23. Escriba un valor para el Recipient’s Phone Number, y haga click en Next.  
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24. Escriba “Quote Information” como el Subject y haga click en Next. 
 

 
 

25. En “Notes”, nos gustaría volver a utilizar datos variables de la secuencia de 
impresión. Para ello, primero haga click en el botón “Click here to select variable 
data”.  En la lista que aparece, seleccione  Description y haga click en Finish. 
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26. Se ha completado la configuracion de su simple flujo de trabajo RightFax.  Los 2 
objetos  (“RightFax Demo” y “RightFax”) deben estar verdes, que significa que se 
han configurado correctamente y el flujo de trabajo está listo para ser creado. 

 
27. Para hacer todos los formularios y cambios adecuados, t debe ejecutar el flujo de 

trabajo.  Para ello, haga click en el botón “Execute”   en la barra de 
menús.   Después de la ejecución, se le notificará de la configuración que ha tenido 
lugar. Haga click en OK. 
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28. Ahora puede cerrar el Workflow Designer. El formulario se ha guardado en el 
directorio de formularios predeterminado.  Un respaldo de su archivo original 
Fax.FOM se ha copiado en la carpeta  “Workflow Designer Original Forms” en el 
directorio de formularios.  Cualquier cambio permanente debe hacerse en este 
formulario original ya que se utiliza en todo el proceso de configuración del 
formulario como plantilla. Si se realizan cambios en esta plantilla, tendrá que 
ejecutar el flujo de trabajo para ver los cambios en los formularios. 

29. El Spooler debe iniciarse ahora haciendo click en Start> Programs> Reform…> 
Spooler.  Una vez abierto, presione el botón Start.  Ahora debería decir Start en la 
esquina inferior izquierda. 

a. Si ya se estaba ejecutando, tendrá que detener y reiniciar el Spooler para 
que reconozca los nuevos formularios que fueron creados por el 
Workflow Designer. 

 
30. Desplácese hasta el directorio \Reform\Backups\. Seleccione el archivo Fax.out, 

haga click derecho en el archivo y seleccione Copy. 

 
 

31. Desplácese hasta el directorio \Reform\Spooler\. Pegue el archivo en el directorio 
Spooler. (Pegar la secuencia de datos para esta carpeta simula la impresión desde 
Windows, AS400, Unix, etc.) 
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32. Cuando la aplicación Spooler comienza a procesar el archivo, se dará cuenta de que 
el nombre del archivo cambia a algo parecido a la imagen de abajo. 
 

 
 
33. Una vez que el documento es enviado por fax, la demostración esta completa. Si no 

obtiene su salida, Reform Spooler podría no tiene los permisos correctos para 
procesar el archivo.  Por favor consulte el manual de Reform 12 para obtener más 
información. Puede reimprimir el documento por copiar el archivo desde el 
directorio de respaldo en el directorio de Spooler de nuevo.  También puede crear 
un nuevo formulario y configurarlo usando el Workflow Designer. 

*Comprobar el servidor de RightFax para asegurarse de que el fax fue enviado 
correctamente. 
*Compruebe su servicio de RM_RightFax para ver si se está ejecutando 

Configuración de Archivos Adjuntos 
Para configurar Reform para utilizar archivos adjuntos con Reform Rightfax, abra su 
Reform Designer. Abra el formulario que desea ajustar y vaya a File > Page Setup. Haga 
click en el botón Attachment Setup al lado de la lista desplegable Transport Type en 
Configuración de Página para abrir el cuadro de diálogo Configuración de Archivos 
Adjuntos. El dialogo Configuración de Archivos Adjuntos, permite elegir entre varios 
tipos de archivo, resoluciones y formatos de color para los datos adjuntos. 
 
El tipo de conexión recomendada para el plugin de RightFax es una imagen TIFF con 
compresión del grupo 4. El Workflow Designer se configura automáticamente para 
usted. 
 
Nota: Puede cambiar el formato de Color en escala de grises o Color, pero 
experimentará una diferencia notable de velocidad. 
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Portada de Fax 
Para utilizar la portada de RightFax en los faxes, abrir el Reform Designer. Abra el 
formulario que desea ajustar y seleccione Options > Automation > Fax Cover Page. En 
lugar de buscar una portada, escriba el nombre de portada de fax que existe en el 
sistema de RightFax. Para utilizar la página de portada de RightFax predeterminada, 
escriba System Default como la portada, como muestra la siguiente imagen. 
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Mantenimiento 
Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con 
el plugin RightFax plugin para Reform 12.  Cada vez que un sistema procesa más y más 
empleos, el tamaño de estos directorios crece muy rápidamente.  En general el 
rendimiento del sistema puede verse afectado por la gran cantidad de espacio que 
pueden ocupar los archivos.  Entradas obsoletas archivos/base de datos se deben 
eliminar de acuerdo a sus necesidades y especificaciones de retención de archivos. Se 
recomienda monitorear el crecimiento de los siguientes directorios: 
 
Directorios: 
C:\Program Files\Reform…\Backups 
C:\Program Files\Reform…\Spooler\ImageQueue 
 

Solución de Problemas 
• cliente RightFax debe estar instalado en el equipo que ejecuta Reform. Reform 

se comunica con RightFax utilizando el puerto 445; Este puerto debe permitirse 
si están ejecutando cualquier firewall o monitores de red. 

• Comprobar la configuración del servidor RightFax incluyendo nombre de 
usuario y el nombre del servidor. 

• Asegúrese de que puede hacer ping en el servidor de fax desde el servidor que 
ejecuta Reform. 

• Compruebe que el RightFax FaxUtil puede conectarse al servidor de RightFax 
correctamente. 

 
Q: No pasa nada después de que el formulario es procesado. Cómo puedo determinar la 
causa de un problema? 
A: Chequear el Registro de Eventos para errores relacionados con Reform o RightFax.  Se 
puede tener acceso al Registro de Eventos yendo a Control Panel > Administrative Tools 
> Event Log.  Esto generalmente le dará una buena idea acerca de por qué pueden estar 
fallando los faxes.   

 
 

Permisos Servicio Rightfax: 
• Ir al Servicio RM_Rightfax y luego a sus propiedades. En la pestania log on, utilice 

una cuenta como administrador y la contraseña para ejecutar el servicio. 
 
 
 
 

 
 

Otros nombres de empresas o productos mencionados en este documento pueden ser 
marcas comerciales o marcas registradas de sus respectivas empresas 
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